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1. Uvod 
 

Namen teh smernic je vzpostaviti enotno in preverljivo metodologijo za izračun deleža lesa in 
lesnih tvoriv v stavbah. V zadnjih letih se v arhitekturi in gradbeništvu povečuje pomen trajnostnih 
materialov, pri čemer ima les posebno vlogo zaradi svojih okoljskih, konstrukcijskih in estetskih 
lastnosti. Kot obnovljiv material z nizkim ogljičnim odtisom je les eden ključnih gradnikov 
zelenega prehoda v gradbeništvu. 

Za naročnike, projektante in odločevalce je zato ključno, da obstaja pregleden postopek, s 
katerim je mogoče natančno določiti, kolikšen delež prostornine stavbe predstavljajo leseni 
elementi. To omogoča primerljivost med različnimi projekti, transparentno presojo pri javnih 
naročilih in podporo trajnostnim investicijam. 

Smernice so pripravljene v skladu z: 

• Zakonom o javnem naročanju (ZJN-3), ki naročnikom nalaga, da pri oddaji javnih naročil 
upoštevajo tudi okoljske, socialne in delovne vidike. V okviru 84. člena je predpisano, da 
morajo merila za izbor vključevati tudi okoljske značilnosti predmeta naročila, kadar je to 
mogoče in smiselno. 

• Uredbo o zelenem javnem naročanju (UZeJN, UL RS št. 51/17, 64/19, 121/21, 44/22 in 
78/23), ki določa obvezne okoljske zahteve za gradnje in javne stavbe. Uredba o ZeJN 
naročnikom nalaga, da v svojih naročilih za projektiranje in izvedbo gradnje stavb izpolnijo 
cilj »delež lesa ali lesnih tvoriv v stavbah znaša najmanj 30 % prostornine vgrajenih 
materialov (brez notranje opreme, plošče pritlične etaže in pod njo ležečih 
konstrukcij), razen če predpis ali namen uporabe to prepoveduje ali onemogoča, pri 
čemer je lahko delež lesa za tretjino manjši, če se v stavbo vgradi najmanj 10 % 
gradbenih proizvodov, ki imajo znak za okolje tipa I ali III«.  

Predstavljena metodologija omogoča, da se delež lesa v stavbi izračuna na pregleden, 
ponovljiv in preverljiv način ter tako neposredno podpira cilje zelenega javnega naročanja 
in zahteve veljavne zakonodaje. Dokument je namenjen predvsem arhitektom, 
projektantom, inženirjem ter pripravljavcem popisov del, ki pri svojem delu uporabljajo 
sodobna orodja (ArchiCAD, AutoCAD, SketchUp, Revit) in pripravljajo popise za gradbene 
projekte. 
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1.2 Namen dokumenta in ciljne skupine 
 

Namen dokumenta je opredeliti jasen, pregleden in preverljiv postopek za izračun deleža lesa 
in lesenih tvoriv v stavbah. 

 
Smernice služijo: 

• arhitektom in projektantom, za pripravo dokumentacije in poročil; 

• investitorjem in javnim naročnikom, pri razpisih in preverjanju trajnostnih kriterijev; 

• ocenjevalcem natečajev, za objektivno primerjavo predlogov; 

• proizvajalcem materialov, ki želijo označiti in potrditi delež lesa v svojih produktih. 

Dokument je v skladu z naslednjimi pravnimi in strateškimi okvirji: 

• Zakon o graditvi objektov (GZ-1) 

• Zakon o spodbujanju rabe obnovljivih virov energije (ZOEE) 

• Evropska taksonomija trajnostnih naložb 

• Izvedbeni dokument ukrepov razvoja lesnopredelovalne industrije do 2030 

• Nacionalni energetski in podnebni načrt (NEPN) 
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2. Pregled tujih praks, kjer je kvantifikacija lesa uradno zahtevana 

V mednarodnem prostoru je kvantifikacija lesa v stavbah formalno določena v standardih, 
certifikacijskih shemah in regulativnih okvirih, ki zahtevajo materialne bilance, izračune 
volumnov konstrukcijskih elementov ter okoljske vplive. Spodaj je zgoščen pregled sistemov, kjer 
je izračun količin lesa obvezen del metodologije. 

Primerjalna tabela uradnih praks 

Država / sistem Zahteva 
izračun? 

Vrsta 
dokumenta 

Področje Vir 

EU Level(s) Da Okvir EU Materialne 
bilance 

European 
Commission – 
Level(s) 

EN 15978 Da Standard LCA CEN – EN 
15978 

DGNB 
(Nemčija) 

Da Certifikat LCA, materiali DGNB System 

SIA 2032 (Švica) Da Standard Embodied 
energy 

SIA 

Lignum EPD 
(Švica) 

Da EPD / LCA Materialne 
bilance 

Lignum 

Finska – 
Environmental 
Declarations 

Da Regulativa LCA, materiali Finnish Ministry 

One Click LCA 
(Finska) 

Da Nacionalna 
baza 

LCA One Click LCA 

Wood First Act 
(Kanada) 

Da Zakon Javne stavbe Government of 
BC 

CaGBC LCA 
(Kanada) 

Da Certifikat LCA CaGBC 

LEED (ZDA) Da Certifikat Materiali USGBC – LEED 
WoodWorks 
Carbon 
Calculator 
(ZDA) 

Posredno Orodje Les, CO₂ WoodWorks 
USA 

BREEAM (UK) Da Certifikat LCA BRE Global – 
BREEAM 

EN 15804 / EPD Da Standard EPD CEN / BRE 
ISO 
14040/14044 

Da Standard LCA ISO 

ISO 21930 Da Standard Materialne 
deklaracije 

ISO 

 

 

 

  



 

Smernice za izračun deleža lesa in lesenih tvoriv v stavbah 

 

6 

3. Definicije in osnovna pravila 

3.1 Kaj štejemo kot les in lesena tvoriva 

V izračun deleža lesa se vključujejo vsi gradbeni elementi iz lesa ali lesnih tvoriv, ki opravljajo 
konstrukcijsko, prostorsko, izolacijsko ali obodno funkcijo v stavbi. 

Kot les se štejejo: 

• masivni les (žagan, lepljen, CLT, BSH, LVL), 

• lesene plošče (iverne, OSB, MDF, vezane), 

• leseni paneli, skeletne stene, ostrešja, stropovi, 

• obloge, fasade, okna, vrata in fiksni leseni pohištveni deli. 

Kot lesena tvoriva se štejejo: 

• materiali z deležem lesnih delcev po prostornini (npr. lesno-cementne, vlaknene plošče, 
kompoziti), 

• hibridni elementi z lesom kot prevladujočim materialom. 

 

Seznam lesnih tvoriv za gradnjo 

•  Masivni les  

• Hlodi, brune  

• Žagan les (deske, letve, morali, tramovi)  

• Masivni lepljen les  

• Križno lepljen (lameliran) les (CLT)  

• Lameliran lepljen les (lepljeni nosilci, glulam, KVH, BSH)  

• Ploščna lesna tvoriva  

• Masivne lesene plošče (opažne, mizarske plošče)  

• Iverne plošče (navadne in OSB)  

• Vlaknene plošče (SB, MDF, HDF)  

• Furnirne vezane plošče  

• Lesno-cementne plošče  

• Lesno-mavčne plošče  

• Lesne izolacijske plošče  

 

• Druga lesna tvoriva  

• I- in T-nosilci  
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• Furnir (za obloge ali za izdelavo vezanih plošč)  

• Lepljen furnirski slojnat les (LVL, PSL, LSL)  

• Masivni parketni elementi in talne obloge  

• Leseni opažni sistemi  

• Lesno-plastični kompoziti (WPC)  

 

 

Osnovno pravilo: 

Vsak element oziroma material prispeva k izračunu glede na dejanski delež lesa po prostornini. 

 

3.2 Elementi, ki se upoštevajo pri izračunu 

V izračun se vključijo volumni: 

1. Nosilne konstrukcije – stene, plošče, strehe, stebri 

2. Sekundarni deli – podkonstrukcije, stopnišča, preklade 

3. Ovoj stavbe – fasade, kritine 

4. Fiksna notranja oprema – stenske in stropne obloge 

Izločijo se: 

• Pohištvo, stavbno pohištvo in oprema, 

• začasne konstrukcije, 

• drobni montažni elementi. 

 

 

 

 

 

 

 

 

 

 

 



 

Smernice za izračun deleža lesa in lesenih tvoriv v stavbah 

 

8 

3.3 Formula za izračun volumna in deleža lesa 

 

Volumen posameznega gradbenega elementa se določi po osnovni geometrijski formuli: 

𝑉𝑖 = 𝐷𝑖 × 𝑆̌𝑖 × 𝑉𝑖 
 

kjer so: 

• Vᵢ – prostornina elementa [m3], 

• Dᵢ – dolžina elementa [m], 

• Šᵢ – širina ali debelina [m], 

• Vᵢ – višina elementa [m]. 

 

 

Rezultat je prostornina elementa Vᵢ v kubičnih metrih [m³].  
Pri BIM modelih se ta podatek navadno izračuna samodejno kot Net Volume po standardu ISO 
16739 (IFC)1, medtem ko se pri klasičnih popisih pridobi z ročnim matematičnim preračunom 
prilagojenim za izračun volumna posameznih teles, ki sestavljajo element, ki je predmet 
izračuna (telesa pravilnih oblik, sfere, nepravilna telesa…) 

Skupni delež lesa v stavbi se nato določi kot razmerje med skupnim volumnom lesenih 
elementov in skupnim volumnom vseh konstrukcijskih elementov stavbe: 

𝑃𝑙𝑒𝑠 =
∑𝑉𝑙𝑒𝑠

∑𝑉𝑠𝑘𝑢𝑝𝑎𝑗
× 100 

 

Rezultat Pₗₑₛ je izražen v odstotkih in prikazuje delež lesa po prostornini.  

Pri kombiniranih elementih (npr. sendvič stene) se upošteva volumen posameznih slojev, pri 
čemer se leseni delež določi glede na volumensko razmerje med materiali. 

 

 

 

 

  

 
1 ISO 16739 (IFC) omogoča standardizirano in interoperabilno predstavitev gradbenih elementov in 
njihovih materialnih lastnosti v BIM-okolju, kar je temelj za avtomatiziran in transparenten izračun deleža 
lesa v stavbah. 



 

Smernice za izračun deleža lesa in lesenih tvoriv v stavbah 

 

9 

4. Postopek v BIM/CAD programih 

 

Uporaba BIM (Building Information Modeling) ali sodobnih 3D CAD orodij bistveno olajša 
izračun deleža lesa v stavbah, saj omogoča natančno določanje materialov, samodejno 
seštevanje volumnov in sledljivost podatkov. 
 

BIM model vsebuje informacije o prostornini, materialu, slojnih sestavah in klasifikaciji 
vsakega elementa, kar pomeni, da lahko sistem avtomatsko prepozna, kolikšen del objekta je 
lesen oziroma iz naravnih materialov. 

Za arhitekte in projektante to pomeni, da ni več potrebno ročno seštevati površin in volumnov — 
zadostuje, da so materiali v modelu dosledno določeni, izvoz pa omogoča natančen izračun v 
nekaj minutah pri čemer je pri vsakem od programov pot različna, ima svojo specifiko in zahteva 
nekaj predpriprave za uspešno izpeljavo. Pri vseh BIM okoljih je še vedno potrebno rezultat delno 
obdelati v excelu ali sicer izračunati posamezne dele lesa napram celoti po klasični metodi 
izračuna deleža napram celoti. Torej vsem programom je skupno, da ne izračunajo deleža 
neposredno, ampak se ga izračuna v dodatnem koraku z deljenjem dveh pridobljenih podatkov o 
volumnih.  

 

4.1 ArchiCAD 

ArchiCAD omogoča najbolj neposreden in pregleden način za izračun prostornine lesenih 
elementov na podlagi pripisanih gradnikov (Building Materials) in konstrukcijskih elementov 
(Wall, Slab, Beam, Column …). Za potrebe izračuna deleža lesa za posamezno skupino oz. 
klasifikacijo je potrebno slediti naslednjim korakom: 

 

1. Korak - Določitev materialov in lastnosti elementov po željeni klasifikaciji (stene, plošče, 
ostrešje, fasadni dekorativni elementi,...) 
• V Building Materials zagotovimo, da so vsi leseni materiali jasno poimenovani (npr. CLT 

120 mm, BSH 200×200, OSB 22 mm). 
• Če uporabljamo kompozitne elemente (npr. sendvič stene), preverimo, da je struktura 

pravilno sestavljena iz posameznih slojev z volumnom. 
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• ustrezno preverimo tudi prioritete posameznih materialov oz. slojev za pravilno 
prekrivanje in izračun 

 

2. Korak - Priprava popisa (Schedules) 
• Odprimo Schedules (Element Schedules). 
• Ustvarimo novo tabelo npr. Volumen gradbenih elementov za posamezne klasifikacije 
• Dodamo lastnosti (Add Criteria) 
• Tip elementa (Wall, Slab, Object …), 
• Building Material ali  
• dodamo filter: izpisujemo samo elemente, ki imajo pripisan material iz skupine “les” ( 

npr. contains "les" ali podobno, da kriterij zajame vse potrebne materiale). 
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3. Korak: Filtriranje elementov (Add Fields) 
• dodajamo po vrsti lastnosti oz. količine, ki jih želimo izvleči iz modela. Ustrezno označimo 

razvrščanje in seštevanje: 
• Material name 
• Element ID za ločen prikaz, npr. po nadstropjih ( 1.N - Fasada, 1.N - Nosilne stene,...) 
• Debelino sloja - Component thickness 
• Volumen sloja - Component Volume (Net) 

 

 

 

4. Korak – Izvozimo pripravljeno tabelo v obliko .xls 
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5. Korak: Izračun deleža lesa  
• tabelo shranimo v xls in urejamo naprej ločeno v programu Excel. 
• V tabelo dodamo stolpec Izračunan volumen lesa: 

o formula = [Net Volume] × [Delež lesa %]. 
• V povzetku (Summary) dobimo vsoto volumnov lesa 

 

 

6. Korak: Rezultat 
• V končnem poročilu imamo dva podatka: 

o Skupni volumen vseh elementov stavbe 
o Skupni volumen lesenih elementov 

 

• Delež lesa določimo z vsoto vseh vključenih volumnov elementov: 
𝑉skupaj = ∑𝑉elementa 

 

• vsoto vseh lesenih volumnov: 

𝑉les = ∑𝑉les 
 

• skupni delež lesa v stavbi: 

delež lesa =
𝑉les

𝑉skupaj
× 100 % 

 

4.2 AutoCAD   

 

AutoCAD sam po sebi nima vgrajenega sistema materialov kot BIM programi, zato je potrebno 
volumne izračunati iz 3D teles (solids) in jih povezati z materialnimi oznakami. 

Korak 1: Modeliranje kot 3D telesa 

• Vsak konstrukcijski element (stena, plošča, steber, streha) mora biti modeliran kot 3D 
solid (npr. s funkcijami Extrude ali push and pull, pomembno je, da so volumni oz. 
geometrijska telesa zaprti, saj le ti omogočajo izračun prostornine). 

Korak 2: Pripis materialov 

• Vsakemu 3D solidu dodelimo atribut materiala: npr. preko Property Sets ali z 
dogovorjeno nomenklaturo (ime sloja, blok z atributom “Material”). 

• Leseni elementi so jasno ločeni (npr. layer “WOOD_CLT”, “WOOD_BSH”). 

Korak 3: Izračun volumna 

• Vpišemo ukaz MASSPROP (Mass Properties) in izberemo 3D solid (3D model). 

• AutoCAD izpiše volumen, površino, težišče ipd. 

• Podatke kopiramo ali izvozimo v tekst/Excel datoteko. 
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Primer osnovnega modela (brez stavbnega pohištva in opreme) na točki označitve 
massprop. Izberemo elemente iz lesa in ločeno ostale elemente. 

Korak 4: Organizacija podatkov 

• Za vse elemente zberemo volumne in jih uredimo v tabelo (Excel). 

• Dodamo stolpec  delež lesa % za lesena tvoriva. 

• Formula za efektivni volumen lesa: [Volumen] × [Leseni delež %]. 

Korak 5: Rezultat 

• Seštejemo volumne vseh elementov, nato volumne lesenih elementov. 

• Končni delež lesa = 𝑉𝑙𝑒𝑠/𝑉𝑠𝑘𝑢𝑝𝑎𝑗 × 100%. 

 

Dodatna priporočila – uporaba vtičnikov 

- Več podjetij predvsem na področju lesene montažne gradnje uporablja razne vtičnike, 
med njimi HSB CAD, ki jim omogoča natančno izvedbo lesenih delov in kosovnice pri 
čemer jim program izvozi tudi volumen lesa, kar je lahko v pomoč pri izračunu, saj je 
podatek dosegljiv nemudoma z izvozom (HSBOutput v opravilni vrstici – Export – Export 
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Primer v HSB Cadu in izvoz količin lesa. 

 

Primer tabele z izvozom rezultata – export report v Excel (rezultat 75,822 m3 lesa na izbranem 
primeru). 
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4.3 SketchUp 

Pri uporabi SketchUpa za pridobivanje količin je ključna ustrezna priprava modela. Za izračun 
volumna in deleža lesa je treba modelirati elemente kot prostorninske objekte, jih jasno 
organizirati po tipologijah materialov ter zagotoviti solidnost posameznih skupin ali komponent. 
SketchUp omogoča izračun volumna preko sistema “Entity Info” in poročil “Generate Report”, 
natančnost rezultatov pa je neposredno odvisna od pravilnega modeliranja in dosledne uporabe 
označevalcev Tag-ov posameznih materialov. V nadaljevanju je opisan standardni pristop. 

 

Korak 1: Osnovna pravila modeliranja 

 

Vsi elementi morajo biti izdelani kot Solid Group ali Solid Component. 
– Geometrija mora biti zaprta, brez notranjih površin, dvojnih robov in odprtih stikov. 
– Konstrukcijski sklopi morajo biti ločeni: zunanje stene, notranje stene, medetažne plošče, 
strešni elementi, leseni okvirji, plošče (OSB, CLT), betonske plošče in drugi sestavi. 
– Elementi vedno vsebujejo realistično debelino materiala, brez površinskega modeliranja. 

Korak 2: Organizacija modela 

– Uporablja se dosledno poimenovanje skupin in komponent. 
– Razvrščanje poteka preko Tag-ov, s predlagano strukturo: 
Leseni elementi: Les_konstrukcija, Les_plosce_OSB, Les_obloge 
Ostali materiali: Beton, Stene_ostalo, Plosce_ostalo, Streha_ostalo, Izolacija 
– Oprema in vsi nerelevantni elementi so na ločenih Tag-ih, izključenih iz izračunov. 

Korak 3: Preverjanje solidnosti 

– Namestitev dodatka Solid Inspector² iz Extension Warehouse. 
– Pregled vseh skupin/komponent in odprava napak: odprti robovi, notranje površine, podvojene 
ploskve. 
– Potrditev solidnosti: SketchUp mora za element prikazati volumen v oknu Entity Info. 

 

Vsak 3d element ima svoje lastnosti, vključno s prostornino v Entity info. 
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Korak 4: Priprava na izračun volumna 

– Nastavitev merskih enot: Window → Model Info → Units → Decimal Meters. 
– Preverjanje volumna posameznih elementov v Entity Info omogoča sprotno kontrolo. 

 

Korak 5: Avtomatski izračun volumnov 

– Uporaba funkcije File → Generate Report. 
– Vključitev atributov: Component Definition, Tag, Volume. 
– Izvoz podatkov v CSV ali Excel in seštevanje volumnov po posameznih Tag-ih. 

 

 

 

Korak 6: Izračun deleža lesa 

– Seštevek volumnov elementov v Tag-ih: 
V_les = Σ (Les_konstrukcija, Les_plosce_OSB, Les_obloge). 
– Seštevek volumnov vseh konstrukcijskih elementov brez opreme: 
V_elem. 
– Izračun deleža: 
delež lesa (%) = (V_les / V_elem) × 100. 

 

Dodatna priporočila 

– Elementi se modelirajo kot polne prostornine, brez votlin. 
– Komponente niso prazne ali delno odprte. 
– Oprema in dekorativni elementi so ločeni in izključeni iz volumenskih analiz. 
– Pred končnim izvozom poročila se ponovno preveri solidnost in izključi vse Tag-e, ki niso del 
konstrukcije. 
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4.4 Revit    
 

Revit omogoča natančen izračun količin, saj vsak element vsebuje parametrično geometrijo in 
materialne lastnosti. Za zanesljiv izračun deleža lesa je ključna dosledna uporaba materialov, 
pravilna nastavitev sestavov (wall/roof/floor assemblies) in organizacija BIM parametrov. Volumni 
materialov se pridobijo neposredno iz Revitovih “Material Takeoff” tabel, zato so rezultati odvisni 
od korektno definiranih materialnih slojev in njihove debeline. Spodnji postopek predstavlja 
standardiziran pristop. Pri tem se podobno kot v drugih okoljih izbere lahko volumen elementov 
iz lesa in lesenih tvorih in se doboljeni volumen ločeno deli z volumno celote t.j. vsote volumnov 
vseh elementov 3D modela. 

Korak 1: Pravilna materialna struktura elementov 

– Vsi gradbeni elementi (walls, floors, roofs, ceilings) morajo imeti natančno definirane 
materialne sloje v “Edit Assembly”. 
– Materiali morajo biti izbrani iz knjižnice kot posamezni “Materials”, ne generični “By Category” 
ali “Default”. 
– Debeline slojev se določijo natančno po projektni zasnovi– Leseni elementi (CLT, OSB, nosilci, 
konstrukcijski okvirji, lesene obloge) so definirani kot ločeni materiali. 

Korak 2: Usklajena organizacija materialov 

– Materiali se razvrstijo v jasno strukturo s predlaganimi kategorijami ali namenskimi “Material 
Class”: 
Leseni materiali: CLT, Glue-lam, Timber Structure, OSB, Wood Finish 
Ostali materiali: Concrete, Masonry, Gypsum, Insulation, Metal 
– Vsi leseni materiali imajo dosledno poimenovanje zaradi filtriranja v tabelah. 
– Uporabljajo se enotne oznake materialov za vse tipologije elementov. 
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Korak 3: Kontrola parametrične pravilnosti 

– Preveri se, da elementi niso modelirani kot “in-place mass”, razen kadar ni druge možnosti. 
– Stene, plošče in strehe morajo biti modelirane kot sistemski elementi (System Families), ne kot 
prosti volumni. 

– Izogibanje elementom brez materialne definicije (npr. Generic Models brez materialov). 
– Pri spojih sten in plošč se preveri korektno prekrivanje, saj Revit zmanjšuje ali povečuje volumne 
glede na “Join Geometry”. 

 

Korak 4: Priprava na izračun materialnih volumnov 

– Nastavitev enot: Manage → Project Units → Volume = m³. 

– Za preverjanje posameznih elementov se uporablja Properties → Materials and Finishes → 
Identity Data → Volume (kadar material podpira volumensko poročanje). 
– Pred izdelavo tabel je treba posodobiti model: Manage → Recalculate Volumes (če uporabljeno). 

 

Korak 5: Material Takeoff tabela 

– Odpre se: View → Schedule → Material Takeoff. 
– Izbere se kategorija (npr. Walls, Floors, Roofs) ali “Multi-Category”. 
– V tabelo se vključijo naslednji parametri: 
– Material: Name 
– Material: Volume 
– Material: Class (če je uporabljeno razvrščanje) 
– Category 
– Family and Type 
– Level, če je potrebna razmejitev po etažah 
– Aktivira se možnost “Calculate materials” (relevantno pri večslojnih elementih). 

 

Korak 6: Filtriranje in združevanje 

– V Material Takeoff tabeli se materiali filtrirajo po materialnih razredih ali po doslednih imenih 
lesnih materialov. 
– Vključi se seštevek: Sorting/Grouping → Grand Totals → Volume. 
– Izdelata se dve ključni vrednosti: 
V_les = seštevek vseh volumov lesnih materialov 
V_elem = seštevek volumov vseh materialov konstrukcijskih elementov (brez opreme in 
dekorativnih slojev, če niso del konstrukcije) 
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Določitev izbora tipa/vrste vezano na material 

 

Korak 7: Izračun deleža lesa 

– Delež se izračuna po formuli: 

delež lesa (%) = (V_les / V_elem) × 100 

– Revitove tabele je možno neposredno izvoziti v Excel (File → Export → Reports → Schedule), kjer 
se izračuni po želji nadalje obdelajo. 

Dodatna priporočila 

– Konstrukcija naj se modelira kot realen večslojni sestav, ne kot enomaterialni blok s 
prilagojenimi lastnostmi. 
– Material “Wood” ali “Timber” ne sme biti uporabljen kot generična oznaka za različne lesene 
tipe. 
– Pri CLT ploščah se uporablja natančna debelina po statičnem predpisu. 
– Elementi, ki niso del konstrukcije (npr. pohištvo, BIM objekti opreme), so razvrščeni v ločene 
kategorije in izključeni iz izračunov. 
– Pri kompleksnih geometrijah (npr. strešne konstrukcije z naklonom) se priporoča dodatna 
kontrola volumna z analitičnim pogledom ali 3D pregledom slojev. 
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5. Postopek v klasičnem popisu del – npr. z uporabo preglednic MS Excel. 

V primerih, ko model ni pripravljen v BIM-programu ali ko podatke o gradbenih elementih 
pridobimo iz drugih virov (npr. popisov del, načrtov ali zunanjih analiz), lahko izračun deleža lesa 
izvedemo neposredno v Excel preglednici. Tak način omogoča preprost, pregleden in ponovljiv 
pristop za prikaz prostornine in deleža lesa v stavbi. 

 

Korak 1: Priprava preglednice 

Ustvarimo tabelo s stolpci, ki vsebujejo osnovne podatke o posameznih elementih: 

• ID elementa (npr. S1, P2, ST3 …) 

• Opis / Tip elementa (stena, plošča, streha, steber …) 

• Širina (Š) 

• Dolžina (D) 

• Višina (V) oziroma debelina elementa 

• Delež lesa % – delež lesa glede na prostornino elementa 

• Izračunan volumen lesa 

• Opombe (po potrebi: vrsta materiala, vir podatka ipd.) 

 

Korak 2: Izračun volumnov 

V stolpec za prostornino elementa vnesemo formulo: 

𝑉elementa = Š × D × V 
 

(če so dimenzije v metrih, bo rezultat izražen v m³) 

Korak 3: Določitev deleža lesa 

Za vsak element določimo dejanski delež lesa glede na prostornino lesenih slojev v njegovi 
sestavi. 
Če je element v celoti lesen, se vpiše 100 %, če pa je sestavljen iz več materialov, se vpiše 
ustrezni izračunani delež lesa. 
V izračun vključujemo le elemente, ki vsebujejo leseni del, ne pa tistih brez lesenih komponent. 

Korak 4: Izračun efektivnega volumna lesa 

Dodamo stolpec “Volumen lesa”, v katerem uporabimo formulo: 

𝑉les = 𝑉elementa ×
Delež lesa

100
 

 

 

 



 

Smernice za izračun deleža lesa in lesenih tvoriv v stavbah 

 

22 

Korak 5: Povzetek in rezultat 

Na dnu tabele dodamo: 

• vsoto vseh vključenih volumnov elementov: 

𝑉skupaj = ∑𝑉elementa 

• vsoto vseh lesenih volumnov: 

𝑉les = ∑𝑉les 

• skupni delež lesa v stavbi: 

delež lesa =
𝑉les

𝑉skupaj
× 100 % 

Primer tabele iz Excela  

 

 

 

 

 

 

 
6. Usmeritve za uporabnike in proizvajalce gradbenih materialov 
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Smernice so namenjene poenotenju pristopa pri načrtovanju, izračunu in vrednotenju deleža lesa 
v stavbah. Z njihovo uporabo se zagotavlja, da so podatki o uporabi lesa primerljivi, pregledni in 
uporabni v vseh fazah projektiranja in javnega naročanja. Metodologija spodbuja vključevanje 
lesa kot trajnostnega in nizkoogljičnega materiala, hkrati pa krepi skladnost projektantske prakse 
z veljavnimi predpisi in okoljskimi cilji. 

Za uspešno izvajanje smernic priporočamo naslednje: 

Usmeritve za projektante in arhitekte 

Projektanti naj dosledno uporabljajo enotno terminologijo za lesene materiale v BIM-modelih ter 
v fazi načrtovanja vključijo tabele (Schedules, Takeoffs), ki omogočajo samodejen izračun 
volumna lesa. Pri pripravi popisov del naj dodajo stolpce za dimenzije, volumen in delež lesa, kar 
omogoča lažji prenos podatkov v preglednice in njihovo nadaljnjo analizo. 

Usmeritve za naročnike in investitorje 

Naročniki in investitorji naj v razpisno dokumentacijo vključijo zahtevo po izračunu deleža lesa v 
skladu s cilji Uredbe o zelenem javnem naročanju kot minimalno tehnično zahtevo ter v skladu z 
namenom rabe objekta višje deleže lesa kot merilo za izbor ponudb. 
Pri ocenjevanju ponudb naj uporabijo prikazano metodologijo skupaj z obrazcem v prilogi 
smernice.. Iz obrazca je razvidna izbrana metodologija, pot izračuna, deli objekta, ki so iz lesa in 
lesenih tvoriv, kar omogoča tudi lažji pregled oziroma preverjanje preostale projektne 
dokumentacije. 

 

Usmeritve za širšo prakso 

Priporočena je uporaba enotnih obrazcev in predlog (npr. Excel in BIM predloge), ki poenostavijo 
in avtomatizirajo izračun deleža lesa.  

Smernice naj bodo vključene v natečajne pogoje, tehnične zahteve in strokovne podlage, delež 
lesa pa naj se uporablja kot kazalnik trajnostne gradnje pri spremljanju učinkov politik na 
nacionalni ravni. 

 

Usmeritve za proizvajalce gradbenih materialov 

Proizvajalci in dobavitelji gradbenih materialov imajo ključno vlogo pri omogočanju natančnih in 
zanesljivih izračunov deleža lesa. Z doslednim označevanjem deleža lesa v tehničnih listih (npr. 
»X % lesne mase po prostornini«) lahko pomembno olajšajo delo arhitektom, projektantom in 
investitorjem.  

Priporočila: 

• v tehničnih listih naj bo jasno naveden delež lesa in lesnih tvoriv, 

• pri kompozitnih ploščah naj bo posebej označen prostorninski delež lesa, 

• v BIM knjižnicah (npr. Revit families) naj bodo vključeni podatki o materialni sestavi, da jih 
sistem prepozna in upošteva v izračunih. 
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Tak pristop povečuje preglednost trga, spodbuja uporabo slovenskih lesnih materialov in krepi 
prehod v trajnostno, nizkoogljično gradnjo. Primer raznih proizvodov in materialov iz lesa in 
lesenih tvoriv z deleži je prikazan v prilogi B tega dokumenta. 

 

Predlog enotnega obrazca za arhitekte 

Za poenostavljeno izvajanje smernic je priložen enoten obrazec za izračun deleža lesa v stavbi 
(Priloga A). 

 
Obrazec omogoča: 

• vnos osnovnih podatkov o projektu in objektu, 

• evidentiranje lesenih gradbenih elementov, 

• izračun skupnega deleža lesa po izbrani metodologiji, 

• navedbo namena izračuna (npr. razpis, subvencija, dokumentacija). 

Uporaba obrazca zagotavlja primerljivost podatkov, poenostavlja postopke preverjanja ter 
omogoča statistično spremljanje deleža lesa v stavbah na nacionalni ravni. 
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7. Zaključek 
 

Smernice za izračun deleža lesa v stavbah vzpostavljajo enoten, pregleden in ponovljiv pristop za 
vrednotenje uporabe lesa v gradbeništvu. Z uporabo sodobnih projektantskih orodij (ArchiCAD, 
AutoCAD, SketchUp, Revit) ter dopolnitvijo popisov del z volumni in deleži materialov v 
preglednicah, kot je MS Excel, postaja izračun deleža lesa dostopen, preverljiv in primerljiv med 
različnimi projekti. Dokument dokazuje, da je delež lesa v stavbi mogoče izračunati na različne 
načine z uporabo različnih projektivnih orodij od katerih je odvisno tudi število korakov, kakor tudi 
porabljen čas. Izkaže se da je pri računalniških programih še posebej ključna predpriprava 
modela v zgodnjih fazah načrtovanje, ki omogoča hitro pridobitev zahtevanih podatkov. 

Smernice zato predstavljajo pomemben korak k: 

• večji uporabi lesa kot domačega, obnovljivega in nizkoogljičnega materiala, 

• uresničevanju ciljev razogljičenja in krožnega gospodarstva, 

• ter skladnosti s slovensko in evropsko zakonodajo na področju trajnostne gradnje. 

Z uvedbo teh postopkov se krepi vloga slovenskega lesarstva, spodbuja kakovostno arhitekturo 
in ustvarjajo pogoji za bolj trajnostno, konkurenčno in zeleno gradnjo prihodnosti. 
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PRILOGA A: PREDLOG ENOTNEGA OBRAZCA 

OBRAZEC ZA IZRAČUN DELEŽA LESA V STAVBI 

1. PODATKI O PROJEKTANTU 
Ime in priimek .................................................... 
Naziv / podjetje .................................................... 
Poklicni naziv ☐ arhitekt  ☐ gradbeni inženir  ☐ drugo: 

__________ 
Številka pooblaščenega inžinirja ☐ ZAPS št. _______   ☐ IZS št. _______ 
Kontakt (e-pošta / telefon) .................................................... 

 

2. PODATKI O PROJEKTU 
Naziv projekta .................................................... 
Naslov / lokacija objekta .................................................... 
Parcelna številka / k.o. .................................................... 
Investitor .................................................... 
Faza dokumentacije ☐ IDP  ☐ DGD  ☐ PZI  ☐ PID  ☐ drugo: 

__________ 
Datum izračuna ____ / ____ / ______ 

 

3. PODATKI O OBJEKTU 
Tip objekta: ☐ stanovanjski ☐ javni ☐ poslovni ☐ industrijski ☐ drugo: __________ 

Konstrukcijski sistem: ☐ lesena (skeletna) ☐ CLT / masivna ☐ kombinirana ☐ klasična 

Gradbeni elementi – označi, če vsebujejo les ali lesne tvoriva 

Element Da Ne Opomba 
Nosilna 
konstrukcija (stene, 
stebri, plošče) 

☐ ☐ ................. 

Ostrešje ☐ ☐ ................. 
Fasada / obloga / 
prezračevalna 
fasada 

☐ ☐ ................. 

Dekorativne obloge ☐ ☐ ................. 
Stopnice, ograje, 
notranja oprema 

☐ ☐ ................. 

Drugo (npr. senčila, 
pergole ipd.) 

☐ ☐ ................. 

    

4. VOLUMENSKI PODATKI 
Postavka Enota Vrednost 
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Skupni bruto volumen 
stavbe (Vstavba) 

m³ __________ 

Skupni volumen gradbenih 
elementov  

m³ __________ 

 

Delež lesa v stavbi: p_les = (Vles / Vstavba) × 100 = __________ % 

5. METODOLOŠKA POT IZRAČUNA 
☐ ArchiCAD 

☐ AutoCAD 

☐ SketchUp 

☐ Revit 

☐ Izračun po popisu (Excel) 

☐ Drug izračun: ______________________________________________ 

 (opis metodologije) 

 

6. NAMEN IZRAČUNA 
☐ Prijava na razpis 

☐ Ugotavljanje skladnosti z zelenim javnim naročanjem 

☐ Projektantska dokumentacija / IDP 

☐ Poročilo za investitorja 

☐ Drugo: ___________________________ 

 

7. IZJAVA PROJEKTANTA 
Podpisani potrjujem, da so zgornji podatki resnični in je izračun izveden skladno s Smernicami 
za izračun deleža lesa v stavbah, pripravljenimi s strani Direktorata za lesarstvo, MGTŠ. 

 

Kraj in datum: __________________________ 

Podpis in žig: ___________________________ 
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PRILOGA B: ORIENTACIJSKI DELEŽI LESA PO PROSTORNINI 

 

Preglednica prikazuje orientacijske deleže lesa po prostornini za najpogostejše lesene in lesne 
kompozitne materiale, ki se uporabljajo v gradbeništvu. Vrednosti so povzete na podlagi 
povprečnih sestav materialov, tehničnih listov in evropskih standardov (EN 13986, EN 16351, EN 
312 ipd.). Podatki služijo kot referenca pri izračunu deleža lesa v stavbah, kadar ni na voljo 
natančnih podatkov proizvajalca. 

 

Skupine lesnih materialov po deležu lesa (volumensko) 

1. MASIVNI LES 

Material Opis in sestava Delež lesa po 
prostornini (%) 

Opomba 

Hlodi, brune Celi drevesni debli, 
neobdelani ali grobo 
obdelani 

~100 % Naravni 
masivni les 

Žagan les (deske, 
letve, morali, tramovi) 

Žagani kosi masivnega lesa ~100 % Brez lepil, poln 
les 

Masivni lepljen les Masivni les, zlepljen iz več 
lamel 

≥ 95–99 % Majhen delež 
lepila 

Križno lepljen les 
(CLT) 

Večslojne križno lepljene 
lamelirane plošče 

≈ 98–99 % 1–2 % lepila 

Lameliran lepljen les 
(glulam, BSH) 

Dolžinsko in širinsko 
lepljene lamele 

≈ 98–99 % Visoko nosilni 
elementi 

KVH Konstrukcijski les, teh. 
sušen, dolžinsko lepljen 

≈ 98–99 % Manj lepila kot 
BSH 

 

2. PLOŠČNA LESNA TVORIVA 

Material Opis in sestava Delež lesa po 
prostornini (%) 

Opomba 

Masivne lesene plošče 
(opažne, mizarske) 

Lepljene masivne 
plošče brez križanja 
lamel 

95–98 % Minimalen delež 
lepila 

Iverne plošče 
(navadne) 

Lesni oblanci + smola 80–90 % Odvisno od gostote 
in smole 

OSB plošče Usmerjeni lesni trakovi 
+ lepilo 

90–95 % Večji delež lesa kot 
klasične ivernke 
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Vlaknene plošče (SB, 
MDF, HDF) 

Lesna vlakna + smola 85–95 % Gostota določa 
delež lepila 

Furnirne vezane 
plošče 

Furnirske plasti križno 
lepljene 

95–98 % 2–5 % lepila 

Lesno-cementne 
plošče 

Lesni sekanci + cement 30–60 % Cement močno 
zmanjša lesni delež 

Lesno-mavčne plošče Lesna vlakna + mavčni 
jedro 

15–25 % Pretežno mineralna 
osnova 

Lesne izolacijske 
plošče 

Mehke ali trde plošče iz 
lesnih vlaken 

~95–99 % Naravno vezane 
(tudi brez lepila) 

 

3. DRUGA LESNA TVORIVA / KOMPOZITI 

Material Opis in sestava Delež lesa po 
prostornini (%) 

Opomba 

I- in T-nosilci Pasovi: masivni les / 
SRP; Steber: OSB ali LVL 

60–90 % Odvisno od 
kombinacije 
materialov 

Furnir Tanki sloji masivnega 
lesa 

~100 % Osnova za vezan les 
ali obloge 

LVL (Laminated 
Veneer Lumber) 

Lepljene furnirske plasti ≈ 97–99 % Zelo visoka nosilnost 

PSL (Parallel Strand 
Lumber) 

Vzporedna lesna vlakna 
+ lepilo 

≈ 90–95 % Industrijski kompozit 

LSL (Laminated 
Strand Lumber) 

Razpršeni oleseni 
trakovi + smola 

≈ 85–95 % Za okvirjaške sisteme 

Masivni parketni 
elementi 

Masivni les ~100 % Če ni troslojen parket 

Leseni opažni 
sistemi 

Masivni ali vezani 
elementi 

90–100 % Uporabno za 
betonska opažiranja 

Lesno-plastični 
kompoziti (WPC) 

Lesni prah + plastika 40–70 % Odvisno od deleža 
polimera 

Opomba: Deleži lesa so orientacijski in se lahko razlikujejo glede na proizvajalca. Za natančne 
izračune uporabite podatke iz tehničnih listov materialov. V izračun deleža lesa se vključujejo 
materiali z vsaj približno 5 % lesa po prostornini, pri čemer se upošteva dejanski delež 
posameznega sloja. 

 

 


